
 Introduktion 3  

For at få adgang til denne 
form for Hjælp … 

gør følgende … 

Hvad er det? Hjælp  Hvis du har en dialogboks åben, gør følgende: 

• Klik på  i øverste højre hjørne af dialogboksen, 
klik derefter på det emne, du ønsker information om. 

• • Flyt markøren til det ønskede emne ved at 
trykke på TAB tasten, tryk derefter F1. 

 

 
Som oftest vil du søge efter en helt specifik oplysning i Hjælp. Den nemmeste måde at 
gøre det på, er at bruge de indbyggede søgefaciliteter: 

Søgning i Hjælp  

 

Brug … når du søger efter … 

Index Trin-for-trin  procedurer, reference eller detaljer og begreber i 
brugergrænsefladen. 

Find Særlige ord eller vendinger, som du ikke kan finde i Index. 
 

Funktionen Hjælp indeholder også fanen Contents, som giver et hierarkisk overblik over 
emnerne i Hjælp. 
 
Hvis du er i tvivl om, hvordan du bruger funktion Hjælp, så tryk F1 for at få Hjælp. Hjælp til Hjælp 

 
De nyeste opdaterede Hjælpefiler, kan downloades fra vort Websted på adressen 
www.7t.dk. Den nemmeste måde at få de nyeste hjælpefiler, er at bruge IGSS Update 
modulet.  I hver enkelt Hjælpefil kan du finde oplysninger om Version i bogen Reference 
på fanen Contents. Der er oplysning om, hvornår Hjælpefilen er lavet og hvilken 
softwareversion, der er beskrevet.   

Opdaterede 
Hjælpefiler 
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Kapitel 1: Velkommen til IGSS 

Oversigt 
 
Dette kapitel giver en introduktion til  IGSS systemet. Om dette kapitel 

 

Dette kapitel indeholder følgende emner. Indhold 

Hvad er IGSS?.......................................................................................................................5 

Oversigt over programmerne.................................................................................................6 
 

Hvad er IGSS? 
IGSS er et Styrings-, Regulerings- og Overvågnings (SRO) system, der anvendes til at overvåge og 
regulere industrielle processer. IGSS anvendes inden for en bred vifte af industrier og har solgt mere end 
25.000 licenser, siden systemet først kom på markedet i 1984.  

Introduktion 

 
IGSS er i drift i adskillige industrier, heriblandt: IGSS 

referenceliste 
• Fødevareproduktion og bryggerier 
• Olie- og gasindustrien  
• Højere uddannelsesanstalter  
• Medicinalindustrien  
• Kraftvarmeværker og affaldsbehandling  
• Skibsautomation  
• Trafikovervågning  
• Renseanlæg  
• Vandforsyning 

Besøg vores websted for at se den fulde liste over referencer og anlægsbeskrivelser for kørende IGSS 
installationer. 
 
IGSS v6 kører under Windows 2003 Server, Windows XP og Windows 2000. For øvrige systemkrav 
henvises til IGSS installationsvejledning, som føler med installations-cd'en. 

Understøttede 
operativsystemer 

 
Systemet retter sig mod to typer brugere: Brugertyper 

• systemkonstruktører, der konstruerer en model af industrianlægget og 
• operatører, der overvåger og kontrollerer anlægget via PC’ere 

 

IGSS er et ægte objektorienteret program. Dette medfører adskillige brugbare fordele for 
systemkonstruktøren og operatøren. Allervigtigst er det, at en proceskomponent, som består af et antal I/O 
punkter, bliver behandlet som et enkelt objekt i IGSS. Dette betyder, at systemkonstruktøren og operatøren 
har den samme opfattelse af et objekt, og at objektets egenskaber kan ses og justeres fra en enkelt 
dialogboks. Objekttyper og -skabeloner er andre objektorienterede udtryk, som bliver brugt i IGSS. 
Skabeloner er især brugbare for systemkonstruktøren idet han kan definere en enkelt skabelon og derefter 
basere ligeså mange objekter med identiske egenskaber på denne skabelon, som han vil. 

Objektorienteret 
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Åbenhed er en af hjørnestenene i IGSS arkitekturen. 7-Technologies tror på, at vores brugere ønsker at 
bruge den nyeste teknologi. Derfor understøtter IGSS mange forskellige standarder, herunder ODBC, SQL, 
OPC, OLE, VBA/Automation og ActiveX. Disse flader giver dig mulighed for at udveksle IGSS data med 
3. parts programmer. Hvis du skal til at lave en kæmpe konfiguration, så ønsker du måske at definere 
proceskomponenterne i en ekstern database og derefter importere data i IGSS. 

Dataudvekslings- 
grænseflader 

 

Muligheden for at skalere er en nøglefunktion til i IGSS. Fordi systemet er baseret på en ægte klient/server 
arkitektur, kan du nemt øge antallet af operatørstationer eller antallet af objekter i din konfiguration. Hvis 
du har en virksomhed spredt på et større område, så kan du endda forbinde fjern-operatørstationer. 

Skalerbarhed  

 
Når du køber IGSS, så behøver du kun at anskaffe det antal objekter, operatørstationer og 
kommunikationsdrivere som du har behov for lige nu. Antallet af objekter og operatørstationer kan til 
enhver tid øges, efterhånden som dine behov vokser. 

Salgsversioner 

Der findes også adskillige redundante løsninger for at minimere nedetid for systemet. Kontakt venligst vor 
salgsafdeling for yderligere informationer.  
 
For at få et mere detaljeret overblik over systemets egenskaber, kan du søge efter "Vigtige funktioner og 
fordele" i den Globale Hjælpefil. 

Yderligere detaljer 

 
For at få et overblik over de nye egenskaber i denne version, kan du søge efter "Versionsinformation?" i 
den Globale Hjælpefil. 

Hvad er nyt i 
denne version  

 

 Oversigt over programmerne  
 
IGSS består af et antal programmer, hver med deres eget specielle formål. Følgende liste over programmer 
er inddelt i de to hovedbrugertyper: Systemkonstruktører og operatører.  

Introduktion 

Nogle af programmerne er ikke en del af standardversionen. I så fald er dette angivet ud for programnavnet. 

For yderligere information om hvert program, brug dets tilhørende funktion Hjælp. 

 Systemkonstruk-
tørprogrammer 

Program bruges således... Programtype 

Definition Bygger en model af den fysiske proces, der 
overvåges, og etablerer forbindelse til de 
fysiske proceskomponenters PLC adresser. 
Forbereder procesdiagrammer til brug for 
operatøren. 

Hovedprogram 

System 
Configuration 

Specificerer globale indstillinger for systemet 
og opsætter relevante 
kommunikationsdrivere for at muliggøre 
kommunikation med PLC’ere. 

Opsætnings-
program 

IGSS Starter Starter og stopper konfigurationen. Hovedprogram 

Job Scheduler Planlægger jobs til automatisk udførelse ved 
regelmæssige intervaller baseret på 
hændelser.  

Tilbehørsprogram 

Maintenance  Opretter vedligeholdelsesjobs, der definerer 
et vedligeholdelsesinterval for specifikke 
proceskomponenter. Når intervallet er 
overskredet, modtager operatøren en 
påmindelse.  

Tilbehørsprogram 

User 
Administration 

Definerer brugernavne og adgangskoder, 
brugergrupper og brugerrettigheder.   

Opsætnings-
program 
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WinPager 1) Opsætter vagtperioder, under hvilke kritiske 
alarmer vil blive sendt til vagthavende 
personales mobiltelefon eller personsøger. 
Ved at kombinere dette modul med vor WAP 
grænseflade får du mulighed for at 
kontrollere procesobjekter og manuelt tilføje 
procesdata til rapporter. 

Tilbehørsprogram 

IGSS Portal Opsæt trådløse enheder til at overvåge og 
kontrollere processer.  

Opsætnings-
program 

 
1) Solgt som separat salgsmodul. 

 
 Operatør-

programmer Program bruges således... Programtype 

Alarm Giver et godt overblik over alarmer enten i 
proces-diagrammer, i Alarmlisten (aktive 
alarmer) eller i Alarmloggen (tidligere 
alarmer). Håndtering af alarmer baseret på 
foreslåede operatørhandlinger og 
dokumentering af procedureafvigelser ved 
hjælp af operatørnoter.  

Hovedprogram 

IGSS Starter Starter og stopper konfigurationen. Hovedprogram 

Maintenance  Få vedligeholdelsespåmindelser i 
vedligeholdelses- eller alarmlisten og udfør de 
relaterede vedligeholdelsesjobs.  

Tilbehørsprogram 

Periodical 
Reports 

Se eller udskriv en rapport for en given periode 
(dagligt, ugentligt, månedligt, kvartårligt eller 
årligt). 

Rapportprogram 

Supervise Overvågning og kontrol af anlægget. 
Alarmhåndtering er en integreret del af 
Supervise. 

Hovedprogram 
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Afsnit B: IGSS skabeloner 

Dette afsnit indeholder følgende information: Om dette afsnit 

• En beskrivelse af hvad en skabelon er og hvad den bruges til 
• Et eksempel hvor vi opretter en digital skabelon. 
 
Dette kapitel indeholder følgende emner. Indhold 
 

Hvad er en IGSS skabelon? ................................................................................................ 43 

Opret en IGSS skabelon...................................................................................................... 44 
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 Hvad er en IGSS skabelon? 
 
En IGSS skabelon er en specialbygget skabelon - baseret på en af IGSS typerne - som 
brugeren laver, når mange objekter ligner hinanden meget og har adskillige fælles 
egenskaber. Den rigtige proceskomponent bliver derefter oprettet ved at benytte 
skabelonen. Således fjernes det gentagne arbejde med at indtaste de samme informationer 
for hver komponent. Faktisk behøver brugeren kun at indtaste et unikt navn og en specifik 
PLC adresse for at lave en ny komponent baseret på skabelonen. 

Definition 

 
Der er flere grunde til at benytte skabeloner meget: Hvorfor benytte 

skabeloner? 
• De sikrer konsistens i konfigurationen for de proceskomponenter, der er baseret på 

almindelige skabeloner. 
• De sparer kostbar ingeniørtid ved at fjerne behovet for at indtaste de samme 

informationer for et antal meget ens proceskomponenter. 
• De begrænser arbejdet med at lave en ny proceskomponent til at indtaste et unikt navn 

og en specifik PLC adresse. 
• De gør det lettere at lave ændringer på mange objekter på en gang, ved simpelthen at 

ændre skabelonegenskaberne 
 
Skabeloner kan defineres for følgende objekttyper: Fire 

skabelontyper  
• Analog 
• Tabel 
• Tæller 
• Digital 

De digitale skabeloner er de mest brugte. Hovedforskellen mellem de digitale skabeloner 
og de andre er, at man opnår kontrol helt ned til hver enkelt bit, som bliver sendt til og fra 
IGSS. For et eksempel på hvordan man definerer en digital skabelon henvises til ”At 
oprette en IGSS skabelon” i dette afsnit. 
 
Nogle få skabeloner følger med og er til fri afbenyttelse, f.eks. skabelonen PROTECT, som 
er en skabelon til at definere beskyttelsesniveauer til brug i forbindelse med 
Brugeradministrationsprogrammet. Hvis nødvendigt kan man oprette nye Protect objekter 
baseret på skabelonen PROTECT. 

Indbyggede 
skabeloner  

 
Lad os for eksempel sige at man har 16 forskellige temperaturmålere i hele dit anlæg, som 
alle sammen 

Eksempel: En 
analog skabelon  

• måler temperaturer inden for området -5 til 35 °C 
• har de samme alarmgrænser 
• har de samme alarmtekster 
• får værdierne på skærmen opdateret hvert 10. sekund 
• skal med i operationsrapporterne 

Her ville det være meget fornuftigt at lave en skabelon, der indeholder alle disse 
egenskaber og så bagefter benytte denne skabelon til at oprette målerne T1 til T16. De 
eneste to egenskaber der er forskellige i disse 16 komponenter er deres navne og deres 
specifikke PLC adresser. 
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Opret en IGSS skabelon 
 
I følgende eksempel vil vi oprette en pumpeskabelon, PUMPE_3. Pumpeskabelonen vil få 
følgende tilstande og kommandoer: 

I dette eksempel 

 

Denne kommando … vil medføre denne tilstand … 

STOP STOP 

LANGSOM LANGSOM 

MIDDEL MIDDEL 

HURTIG HURTIG 

 
 

Når du opretter en digital skabelon, kan du: Fordele ved at 
benytte en digital 
skabelon • oprette det præcise antal tilstande og kommandoer, du har brug for 

• give tilstandene og kommandoerne dine egne navne 
• oprette et hvilket som helst antal alarmer 
• opnå kontrol helt ned til hver enkelt bit 
• skræddersy en skabelon, som kan benyttes igen og igen 

Normalt vil man oprette en skabelon for hver type, ventil, motor, pumpe, osv. Hvis du skal 
benytte to skabeloner til to forskellige pumpetyper, så er det simpelthen at kopiere den 
første skabelon (Vælg Skabelon →  Opret skabelon) og brug funktionen Kopier fra, lave de 
nødvendige justeringer og give den et nyt navn, f.eks. PUMPE_2. 
 
 At oprette en 

digital skabelon Trin Handling 

1. Vælg Skabelon → Opret skabelon. Dialogboksen Opret skabelon vises. 

2. I gruppen Type, vælg Digital og indtast et unikt navn for skabelonen (her: 
PUMPE_3) og klik OK. Dialogboksen med egenskaber for digitale skabeloner 
vises. 

BEMÆRK: For at gøre det nemt at skelne mellem skabeloner og 
proceskomponenter, anbefaler vi, at du bruger store bogstaver til 
skabelonnavne og store og små bogstaver til proceskomponenter. 

3. Definer de bits der skal bruges til tilstande og kommandoer (se fanen ”I/O 
bitmønster” herunder). 

4. Definer de bits der skal bruges til alarmindikation og alarmkvittering (se 
fanen ”Bitmønster for alarmer” herunder). 

5. Tildel navne til de enkelte tilstande og kommandoer ( se fanen ”Tilstande og 
kommandoer” herunder). 

6. Definer standardkommandoen og de lovlige kommandoer for hver enkel 
tilstand. (se fanen “Konfigurer kommando/tilstand” herunder). 

7. Angiv hvordan du vil samle og logge dine data. (se fanen “Databehandling” 
herunder). 

8. Bestem de dele af PLC adressen som er fælles for alle de 
proceskomponenter, du vil basere på denne skabelon. (Se fanen “PLC 
adresse/alarmtekst” herunder). 

9. Vælg farver og symboler til at repræsentere hver tilstand. (se fanen 
“Symbol” herunder). 
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Trin Handling 

10. Klik OK for at gemme skabelonen.. 

RESULTAT:   Skabelonen er nu klar til brug. For et eksempel hvor vi 
benytter en skabelon til at oprette en proceskomponent henvises til ”Opret 
digitale skabeloner” i kapitel 3.. 

 
Figuren herunder viser fanen I/O bitmønster: Fanen I/O 

bitmønster  

 
 Figur 2.28 På denne fane bestemmer du hvordan du vil bruge de enkelte bits som sendes til 

og fra IGSS . 

Denne fane indeholder følgende vigtige objektegenskaber: 
 
 

Egenskab Beskrivelse 

Til PC 
(Tilstand) 

Her defineres hvordan man vil bruge de enkelte bits, som bliver 
kommunikeret fra PLC’en til IGSS. Man har 32 bits til tilstands- og 
kommandoindikatorer.  

I dette eksempel bliver bit 0 og 1 brugt som tilstandsbits. Symbolerne er 
beskrevet i Symbolforklaring. 

Fra PC 
(Komman-
do) 

Her defineres hvordan man vil bruge de kommandobits, som bliver sendt 
fra IGSS til PLC’en. Her bliver der brugt to kommandobits. Ligesom de 
to bits for tilstandene, så giver 2 bits mulighed for at navngive 4 
kommandoer. De fire kommandoer repræsenterer 4-bits kombinationerne: 
00, 01, 10, 11. 

 

For en forklaring på de resterende emner, skal du klikke på   i øverste højre hjørne af 
dialogboksen og bagefter klikke på det emne, du vil have information om. 
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Figuren herunder viser fanen Bitmønster for alarmer: Fanen Bitmønster 
for alarmer 

 
 Figur 2.29 På denne fane bestemmer du, hvordan du vil bruge de enkelte bits, som sendes til 

og fra IGSS. 

Denne fane indeholder følgende vigtige objektegenskaber: 
 

Egenskab Beskrivelse 

Til PC 
 

Definer den alarmindikationsbit eller alarmkvitteringsbit som bliver 
kommunikeret fra PLC’en til IGSS. 

I dette eksempel bruges bit 0 som alarmindikation og bit (+) og 1 som 
alarmkvitteringsbit (*). 

Fra PC 
 

Definer den alarmkvitteringsbit som bliver kommunikeret fra IGSS til 
PLC’en. 

I dette eksempel bruges bit 0 som alarmkvitteringsbit. (*).  
 

TIP: Det anbefales at sætte en kvitteringsbit både Til PC og Fra PC. Dette sikrer at 
operatørens kvittering sendes til PLC’en og at  IGSS modtager en kvittering tilbage fra 
PLC’en. Hvis du kun sætter den Fra PC, kan du ikke være sikker på, at PLC’en har 
modtaget bit’en.   
For flere detaljer om alarmindikations- og kvitteringsbits, søg efter ”alarms” i funktionen 
Hjælp i IGSS Definition. 
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Figuren herunder viser Tilstande og kommandoer: Fanen Tilstande 
og kommandoer  

 
 Figur 2.30 På denne fane angiver du navnene på den digitale skabelons tilstande og 

kommandoer.   

Denne fane indeholder følgende vigtige objektegenskaber: 
BEMÆRK: Antallet af tilstande og kommandoer bestemmes af det antal tilstands- og 
kommandobits, der blev defineret i fanen I/O Bitmønster. 
 

Egenskab Beskrivelse 

Tilføj Tilstand  Omdøber den valgte tilstand i feltet med det tilstandsnavn, man 
indtaster eller vælger. Man kan enten indtaste et nyt tilstandsnavn 
eller vælge en allerede eksisterende tilstand ved at åbne rullelisten. 

Tilføj 
Kommando  

Omdøber den valgte kommando med det navn man indtaster eller 
vælger. Man kan enten indtaste et nyt tilstandsnavn eller vælge en 
allerede eksisterende tilstand ved at åbne rullelisten. 

 

 
På denne fane angiver man, hvordan man vil samle og logge data. Denne fane er identisk 
med den for analoge objekter. I dette eksempel har vi valgt Logning Ud, hvilket betyder, at 
alle kommandoer, operatøren sætter i gang, vil blive registreret i systemets logfiler. Vi 
vælger  
> 0 %, fordi vi vil logge alle tilstandsændringer. Hvert femte minut gemmer systemet 
antallet af tilstandsændringer i .bcl filerne (datareduktionsmetoden Ændre er valgt). Disse 
værdier bruges senere i beregningen af værdier til operationsrapporterne. 

Fanen 
Databehandling  

For yderligere information om denne fane henvises til  afsnittet ”Objekttype Analog”. 
 
På denne fane angiver man proceskomponentens PLC adresse. Bemærk at en fuld PLC 
adresse består af et nodenummer, en datagruppe, et ord offset og et bit offset. 

Fanen              
PLC adresse/ 
alarmtekst  

BEMÆRK: Husk at vi opretter en skabelon, og derfor kan vi ikke angive en specifik PLC 
adresse. Vi kan dog gøre det, at vi angiver nodenummeret, datagruppen og ord offsettet og 
lader bit offsettet stå åbent således, at det kan angives for de enkelte objekter, når de 
efterfølgende bliver oprettet. 

At angive alarmtekster giver ikke nogen problemer - alle de komponenter, som senere vil 
blive baseret på denne skabelon, vil indeholde de samme alarmtekster. 

For yderligere information om denne fane henvises til  afsnittet ”Objekttype Analog”. 
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Anvend standardindstillingerne i konfigurationen. Hvis der vælges et andet sprog end 
dansk, skal man være opmærksom på at denne manual er baseret på dansk sprog. 

At indstille 
Supervise & 
Language 
parametre 

 
 

På denne fane defineres indstillingerne for programmet Overvågning og valg af sprog.  Fanen Supervise 
& Language 

De vigtigste parametre er følgende: 
 

Parameter Beskrivelse  

Allow diagram 
move 

Feltet afkrydses hvis man vil give operatøren lov til at ændre på 
diagrammernes placering i programmet Overvågning. 

Allow diagram 
resize 

Feltet afkrydses hvis man vil give operatøren lov til at ændre på 
diagrammernes størrelse i programmet Overvågning. 

Allow graph move 
& resize 

Feltet afkrydses hvis man vil give operatøren lov til at ændre på 
diagrammernes placering og størrelse i programmet Overvågning. 

Allow editing of 
graph 

Feltet afkrydses hvis man vil give operatøren lov til at ændre på 
kurveopsætningen i programmet Overvågning. 

Select Language Her vælges hvilket sprog IGSS skal vises med. Tilgængelige sprog 
er følgende: tjekkisk, dansk, tysk, engelsk, spansk, estisk, fransk 
islandsk, lettisk, hollandsk, norsk, polsk, russisk og svensk. 

  

Opsætning af driverparametre  
 
Dette er en mere detaljeret beskrivelse af driverdefinitionen. Formål 

 
Dette eksempel I denne konfiguration, bruger vi Siemens serial 3964R/RK512 interface driver, der er 

direkte tilsluttet til COM1 porten på IGSS enkeltbrugerstationen. Vi definerer en node 
(PLC), som alle proceskomponenterne er forbundet til.   
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Udfør følgende trin: At definere 

driveropsætning  

Trin Handling 

1. Klik på ikonet IGSSStation1, , i træstrukturen til venstre. 

Vælg Edit → New Driver eller klik  og dobbeltklik på Siemens serial 
3964R/RK512 interface driver. 

 
Figur 3.5  Dobbeltklik på den driver, du vil anvende. 

2. 
Vælg Edit → New Interface eller klik på  Der tilføjes automatisk en  
COM1 port til træstrukturen.  

Bemærk:  For at bruge en anden COM port eller indstille 
kommunikationsparametrene, kan du klikke på fanen Serial Port og ændre 
valgmulighederne, om nødvendigt.   

3. Klik på + tegnet ved siden af  COM1 og bemærk, at  IGSS automatisk har 
tilføjet den første node (PLC). Vælg nodeikonet for at se nodeegenskaberne. 
Som du kan se foreslås nodenummer 0 og vil bibeholder denne indstilling.  

Figur 3.6  Træstrukturen viser alle komponenterne i systemopsætningen. Du kan vise 
hele strukturen eller folde det sammen ved at bruge + og - tegnene.   
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4. Vælg File → Save and Exit. Der returneres til programmet Definition, og 
man kan nu begynde at designe konfigurationen. 

 

 
Hvis man har behov for at kommunikere med PLC’ere, der ikke har direkte forbindelse til 
en IGSS server eller operatørstation, kan man kommunikere med disse PLC’ere (kaldet 
undernoder i IGSS) via en administrationsnode (gateway PLC). Dette kan være tilfældet, 
hvis man har to adskilte netværk på et anlæg, et LAN netværk og et dedikeret PLC 
netværk. Gateway PLC’en ville i så fald være tilgængelig via LAN netværket og ville 
kunne håndtere al kommunikation til undernoden(erne) på PLC netværket. 

Undernoder 

For yderligere detaljer om undernoder, søg efter "subnodes" i funktionen Hjælp i System 
Configuration. 
 
I System Configuration kan man udveksle forskellige typer telegrammer mellem IGSS og 
PLC’erne (noderne). Disse telegrammer indeholder systemhændelser, synkronisering af tid 
og Keep Alive telegrammer. De defineres på fanen Advanced på nodeniveauet. 

Specielle 
telegramtyper 

For yderligere detaljer, søg efter "telegrams; using extended services" i funktionen Hjælp i 
System Configuration. 

 Lav baggrundstegninger  
 
En baggrundstegning til konfigurationen viser alt det statiske i processen. De dynamiske 
proceskomponenter bliver oprettet efterfølgende i IGSS Definition. 

Formål 

NOTE: Du kan også bruge baggrundsfarve til dine diagrammer og bygge procesbilledet 
op fra bunden.  
 
For at bruge baggrundstegninger i IGSS, skal de gemmes i en af de understøttede formater. 
For at se listen over understøttede formater skal du åbne dialogboksen Diagram 
egenskaber, vælge Billede, klikke på Gennemse og åbne rullelisten Files of type. Til 
understøttede filformater hører velkendte formater, der bruges på Internettet (*.jpg og 
*.gif). 

Understøttede 
formater  

TIP: Du kan også bruge specifikke tegneprogramformater, f.eks. CorelDraw (*.cdr), 
Adobe Photoshop (*.psd), etc. 
 
Udfør følgende trin: At lave en 

baggrundstegning  

Trin Handling 

1. Åbn det tegneprogram, du har valgt at bruge, f.eks. CorelDraw. 
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2. Tegn baggrundsbilledet. Tegn alt med som er statisk i processen.   

TIP: Du behøver ikke tage statisk tekst med på billedet. Dette kan gøres 
direkte i Definition, hvor teksten frit kan formateres. 

 
 Figur 3.7 Baggrundsbilledet er lavet i en ekstern tegneapplikation. 

3. Gem eller konverter billedet til et af de understøttede formater. 

BEMÆRK: Baggrundsbilledet bliver valgt senere som en del af 
oprettelsesproceduren. 

 

 

 Planlægge alarmtekster 
 
Det anbefales at planlægge og strukturere alarmtekster, prioriteter og alarmfarver på et 
tidligt tidspunkt i konfigurationsprocessen for at bevare en konsistens. Planlægning af 
beslutninger indebærer fastlæggelse af alarmprioriteter, der skal bruges, hvilken farve, der 
skal forbindes til hver alarmprioritet, genbrug af alarmtekster (den samme alarmtekst kan 
knyttes til lige så mange objekter, som du ønsker). 

Formål 

 
En alarmtekst er en general beskrivelse af en fejlsituation, f.eks. ”Motor overophedet”. 
Hver alarm tekst består af følgende komponenter: 

Hvad er en 
alarmtekst? 

 

Komponent Beskrivelse 

Alarm Nr. Viser alarmteksten med et unikt alarmnummer. Hvis man opretter en 
ny alarmtekst, bliver det næste tilgængelige alarmnummer 
automatisk foreslået, men det kan man ændre hvis det er nødvendigt  

Prioritet Vælg en prioritet fra 255 (højeste prioritet) til 1 (laveste prioritet). 

TIP: Vær omhyggelig med at planlægge alarmprioriteterne og deres 
forbundne farver. For at gøre det lettere for operatøren at forstå 
alarmprioriteten med det samme, så vær konsistent og brug kun et 
begrænset antal alarmprioriteter. 

Alarm og 
kvitterings- 
farver 

Vælg farver for tilstandene alarm og kvittering og slå til/fra om 
objektssymbolerne skal blinke på procesdiagrammet. 

TIP: For at gøre det lettere for operatøren at skelne mellem et objekt 
i alarm og et objekt, hvor der kvitteret for alarmen, afkryds da 
Blinkende for alarmfarven og undlad at afkrydse feltet for 
kvitteringsfarve.  

Alarmtekst Lav en kort beskrivelse af alarmsituationen. Det er den tekst, som 
operatøren vil se på alarmlisten, når alarmen forekommer. 
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Lyd Det bør overvejes om man vil have lyd på, når denne alarm 
forekommer. Lyden kan være enten et bip eller en lydfil (*.wav). 

Alarmhændelse Her vælges den hændelse/de hændelser, man vil sætte i gang, når 
denne alarm forekommer. Følgende hændelser er tilgængelige: 

• Til WinPager sender alarmnummeret via WinPager til en 
mobiltelefon eller personsøger. Brug denne funktion til at sikre at 
en alarm bliver håndteret i perioder, hvor operatørstationen er 
ubemandet. WinPager er et separat salgsmodul. 

• Til PLC sender et alarmændringstelegram til den valgte PLC, 
forudsat at den er aktiveret i System Configuration. 

• Udskriv udskriver alarmteksten på alarmprinteren. 
• Kvitter automatisk kvitterer automatisk når alarmen forekommer. 

Brug denne indstilling for midlertidige alarmer. 
Operatørin-
struktioner 

Giver forslag til hvad operatøren skal gøre, hvis denne 
alarmsituation skulle opstå. Operatøren har adgang til 
instruktionerne fra procesdiagrammet og fra alarmlisten. 

Kopier fra Vælg en eksisterende alarmtekst i rullelisten, klik derefter Kopier for 
at indsætte egenskaberne i den aktuelle alarmtekst. Egenskaberne 
kan derefter frit ændres. 

 

 Tegn nye symboler  
 
IGSS har et stort symbolbibliotek (omkring 150 symboler). Hvis disse symboler er 
tilstrækkelige, kan man springe denne procedure over. Man kan imidlertid ændre på de 
eksisterende symboler eller tegne nye symboler. 

Formål 

TIP: De indbyggede symboler er ensfarvede. Men flerfarvedesymboler kan også tegnes. 
Se hjælpen til Definition. 

 

Det ovennævnte symbolbibliotek er indeholdt i symbolfilen Symbols.v20. Filen består af 
et antal undertabeller, som hver indeholder symboler for en bestemt type komponent, 
f.eks. ventiler. Navnene på undertabellerne i Symbols.v20 er dem, man ser i den nederste 
del af menuen Objekt og på fanen Symbol, når man opretter proceskomponenter. Man kan 
ændre navnene på undertabellerne i Symbol Editor. 

Symboltabeller  

 
Udfør følgende trin: At tegne nye 

symboler  

Trin Handling 

1. Klik Start → Programmer → IGSS 6.x → Definition. 
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2. Vælg Rediger → Symboler.... Dialogen IGSS Definition – Symbol Editor 
vises. 

3. I listen Liste over symboltabeller, klik på den symboltabel som du vil føje det 
nye symbol til. 

4. Brug rullelisten til at finde en tom symbolplads, markeret med No Name og 
vælg den. 

5. Tegn det nye symbol. 

6. Klik Luk for at lukke programmet Symbol Editor. 

RESULTAT: Du kan nu vælge det nye symbol, når du opretter en ny 
proceskomponent i IGSS Definition. 

 

 

 Tilbageblik på checklisten – Opsætning og forudindstilling 
 
Fasen Opsætning og forudindstilling er nu fuldført. For at opsummere, så har vi nu gjort 
følgende: 

Tilbageblik 

Procedure Sæt kryds efter udførelse 

Opret en ny konfiguration √ 

Opsætning af stationsparametre √ 

Opsætning af Driver parametre √ 

Lav baggrundstegninger √ 

Planlæg alarmtekster √ 

Tegn nye symboler √ 
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 Afsnit C: Opbygning af konfigurationen  

Oversigt 
 
Dette afsnit indeholder følgende information: Om dette afsnit 

• En kort introduktion til to IGSS Definition 
• Trin-for-trin procedurer til at lave et konfigurationseksempel 
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